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Introduction  
Purpose 
This manual details the usage and behavior of the DataSplice Remote Client.  The views 
examined in this guide represent a typical set of inventory views for a Computerized 
Maintenance Management System (CMMS) environment.  This guide will discuss the 
typical behavior of these views when used under normal conditions. 

It is important to remember that other implementations may require completely different 
views.  All views can be completely customized to fulfill the specific needs of any 
application.  Modifications made to the views by administrators are not reflected in this 
document. 

For additional documentation and support resources, please visit 
http://support.datasplice.com. 

Version Information 
 
The information in this document is valid and current with DataSplice version 2.3.10.0. 
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User Interface 
The first step in learning how to successfully use the DataSplice Remote Client is to 
familiarize yourself with the user interface of the program.  The user interface can be 
broken down into a few important general sections: 

User Interface 
 

1. Toolbar Buttons 
2. Menus 
3. Navigation 
4. Filters 
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Toolbar Buttons 
The user interface of the DataSplice Remote Client has numerous components. One of 
these components is the toolbar, which is composed of a series of buttons. The following 
is a brief explanation of these toolbar buttons. 
 

Show View List 

 

This button displays the list of views available to the user. Changes made to the 
view display or records while in a view are not affected by navigating to the 
view list. For example, a user has set a view to sort in descending order and then 
navigates off the view. When the user returns to the view, the sort will appear as 
the user left it. 

Toggle Display 

 

This button switches the view between grid display and vertical display for the 
current view. Grid mode displays multiple records at one time. Records are 
displayed horizontally, one record per line. Grid mode is especially useful while 
searching through records. Vertical mode displays one record at a time. Field 
names are displayed in a column on the left side of the screen. The 
corresponding values are displayed on the right. Vertical mode is optimal for 
editing records. 

Back 

 

This button navigates the user through previous views. This is similar to using 
the Back button in a web browser. 

Next 

 

This button displays the next record(s). When in vertical display mode, tapping 
this button will take you to the next record in the current set. When in grid 
display mode, tapping this button will show you the next set of records. 

Previous 

 

This button displays the previous record(s). When in vertical display mode, 
tapping this button will take you to the previous record in the current set. When 
in grid display mode, tapping this button will show you the previous set of 
records. 
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New Record 

 

This button creates a new record in the designated view. The new record may be 
blank, may have some fields populated with default values, or may have all 
values from an originating record duplicated. 

Delete Record 

 

This button removes the selected record permanently.  Note: Items deleted are 
not sent to the Recycle Bin, and the Delete command cannot be reversed. 

Commit Changes 

 

This button saves all record modifications. Records are committed in the order 
in which they are modified. To view the list of modifications, select 
Modification History from the View menu. 

Search 

 

This button retrieves specified records. Filter fields define the criteria upon 
which the records will be searched. 
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Menus 
File Menu 

 
 

Connect Tapping on this menu item connects the Remote Client to the DataSplice 
Server. When connected, this menu item changes to Disconnect, at which 
time tapping it will disconnect the Remote Client from the DataSplice 
Server. 

Connection Settings Tapping this item opens the Advanced Connection Settings dialog box: 
 

 
 
This area specifies the address of the DataSplice Server, along with other 
properties like the number of records to view per page. 

Commit Changes Tapping this menu item saves all record modifications. Records are 
committed in the order in which they are modified. To view the list of 
modifications, select Modification History from the View menu. 

Login Screen Tapping this selection opens the Login screen. This action does not affect 
the connection status. 

Show View List Tapping this option opens the list of views available to the user logged in. 
The view list displayed is based on the class of the most recent view. To 
view another view class or all available views, select the appropriate 
option from the Select View dropdown box. 

Export Grid 
 

Tapping this item opens the Export Settings dialog box: 
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Exporting a grid sends all visible information from the current view to an 
external file. 

Change Password This opens the Change Password dialog box. DataSplice users can 
change their passwords at any time. Additionally, some users may be 
required to change their password by the DataSplice Administrator. 
Contact the DataSplice Administrator if your password is lost or 
compromised. 

About This opens the About DataSplice dialog box. This box contains read-only 
information about the current version of the Remote Client application. 

Exit This closes the DataSplice Remote Client application. If the Save Offline 
Data to Disk option is selected and the user has an offline session, record 
modifications will be cached. The user is asked to commit data upon 
disconnect and reconnect. 

Edit Menu 

 
 

Cut The Cut command places the selected data into the clipboard and deletes it from its current 
position. Copying, cutting and pasting information reduces the likelihood of data entry errors 
and keeps information in the same format. Some underlying databases are case-sensitive, 
which means that filtering on Joe Smith will provide a different set of records than filtering 
on JOE SMITH. 

Copy The Copy command places the selected data into the clipboard without affecting the data 
itself. 

Paste The Paste command places information currently in the clipboard into the selected field. 
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View Menu 

 
 

Toolbar When checked, the Toolbar is visible. 
Status Bar When checked, the Status Bar is visible. 

Filter When checked, the Filter fields are visible. This option will appear grayed 
out for users who have had this option removed by an Administrator with the 
DS_NO_FILTER attribute. 

Modification History Modification History displays all record modifications in the order in which 
they were completed. 

Set Grid Font Changes the type size of the characters within the data grid. You may choose 
from any fonts installed on your Windows platform. 

Session Menu 

 
 

Get Offline 
Data 

 
 
 

Retrieve records marked as Offline. A green circle indicates the records that are 
available offline. This circle is viewable in both online and offline mode. View 
definitions determine which records are marked as Offline by default. The user can 
select which offline views they wish to download by checking the box next to the view 
in the Offline Views dialog. This allows static views, views that don’t change, to be 
skipped, which reduces the time it takes to download offline data. 

Get Selected 
Offline 

Add records that are not marked as Offline records to the set of records available 
offline. 

Release Offline 
Session 

This return offline license to the license pool. After an offline session is released, the 
session becomes online-only until new offline records are retrieved. 

Clear Session This clears the current session. 
Search All The Search All option queries all the records that have been committed to the database. 

This option is only available while online. Uncommitted modifications will not be 
reflected in the query. Therefore, to avoid inaccurate searches, it is a good idea to 
commit all changes before searching. 

Search Offline The Search Offline option queries local records that have been marked as Offline 
records. 

Search 
Modified 

The Search Modified option queries only local records which have uncommitted 
modifications. 
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Records Menu 

 
 

Narrow Search Adds the currently highlighted field to the filter.  
Clear Screen The Clear Screen command resets the filter to the default criteria and clears any 

displayed records. 
Reset Record 

Changes 
The Reset Changes command reverts the record to the last committed version. 

Apply Record 
Changes 

The Apply Record Changes command commits changes to the selected record 
only. 

Delete Record The Delete Record command deletes an entire record from the database. 
New Record The New Record command creates a new blank record.  Fields with default values 

will be auto-populated. 
Edit Complex 

Filter 
Opens the filter in grid mode. Conditions inserted in the same column are run with 
the AND operator. Different columns are concatenated together in the filter using an 
OR condition. 
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Navigation 
On certain views, it may be possible to navigate to other views which have a special 
relationship to the one you are currently looking at.  In such instances, you can use the 
navigation links towards the bottom of the window to move to that other related view. 
 
Navigation 

 

To navigate to the associated view for 
the current record: 
 

1. Tap the navigation menu. It is 
displayed in blue next to the Go 
button. 

2. From the navigation links, select the 
work process of interest, such as 
Review Material Issues. 

3. Tap the Go button.  This will 
navigate you to the selected screen, 
such as Review Staged Parts, and 
automatically filter the record 
selection based on the record you are 
navigating from. 
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Filters 
As you are looking at views in the DataSplice Remote Client, you may want to search for 
particular items in the view that meet specific criteria.  The filter field determines the 
criteria used to retrieve records from the database.  The records returned from the query 
will have the same value in the specified field. 

Filter Operators 
Filter operators allow you to choose how you would like to compare the field in question 
and the value of that field you want to find. 
 

= Equal to 
< Less than 
> Greater than 

<= Less than or equal to 
>= Greater than or equal to 
<> Not equal to 

IS NULL Returns values which are null 
IS NOT NULL Returns values which are not null 

Wildcards 
A wildcard is a placeholder for characters that do not have to be specified.  Wildcards can 
be used in the filter field.  For example, the records for all employees whose employee 
numbers begin with 27 can be retrieved by using a wildcard.  In this case, the filter field 
would be Employee Number, and the value in the field would be 27%.  The percent sign 
indicates that anything can follow the 27.  In this particular case, all of the following 
numbers could be returned: 27, 270, and 27462983. 
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Simple Filters 
Creating a Simple Filter 

 

To create a simple filter: 
 

1. Tap the blue filter field. A 
dropdown box will appear. 

2. From the dropdown list, choose the 
field you would like to search on, 
such as Point Num. 

3. Tap on the blue “=” character to 
choose which operator you would 
like to use. For more information, 
please see the Filter Operators 
section above. 

4. In the text field, enter the value you 
would like to find. 

5. Tap the Search button  to 
retrieve the records. 

 
Creating Multiple Filters 

 

To create multiple filters: 
 

1. Tap the blue filter field. A 
dropdown box will appear. 

2. From the dropdown list, choose 
Add New Field. Another filter field 
will appear below the original one. 

3. Tap the new filter field. The same 
dropdown box will appear. From 
the dropdown list, select the field of 
interest. 

4. Tap on the blue “=” character next 
to each filter field to choose which 
operator you would like to use for 
each of the filter fields. For more 
information, please see the Filter 
Operators section above. 

5. In the text fields, enter values to 
search on for both filter fields. 

6. Tap the Search button  to 
retrieve the records. 
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Complex Filters 
Complex filters are more powerful than simple filters because they can be combined to 
further refine the data displayed. 
 
Filters in the same column are joined with an AND operation. The records retrieved must 
meet all of the conditions of all of the filters in that row. 
 
Filters in the same row are joined by an OR operation. The records retrieved must meet 
all of the conditions of at least one of the filters. 
 
Creating Complex Filters 

 

To create a complex filter: 
 

1. From the Records menu at the 
bottom of the screen, choose Edit 
Complex Filter. This will change 
the filter area to two columns, titled 
Filter 1 and Filter 2. 

2. Double tap in a field to create a 
filter. You will be shown a screen 
with value fields for Display 
Name, Test, and Value. 

3. Fill in the Display Name, Test, and 
Value fields as desired. The 
Display Name and Test fields are 
both dropdown lists. 

4. Tap OK. 
5. The new filter will now appear in 

the filter grid. 
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Advanced Filters 
The basic filtering technique (selecting field, test, and value) works for most situations 
and is preferred because it ensures correct syntax in the query statements. More advanced 
filters may be created by checking the Plain Text Filter box on the Edit Filter Item 
dialog box and entering a custom SQL statement. This provides the opportunity to create 
unique filters based on the syntax of the particular database view by inputting text that 
will be inserted into the where clause without modification. 
 
Creating Advanced Filters 

 

To create an advanced filter: 
 

1. From the menu at the bottom of the 
screen, tap Records > Edit 
Complex Filter. This will change 
the filter area to two columns, titled 
Filter 1 and Filter 2. 

2. Double tap in a field to create a 
filter. You will be shown a screen 
with value fields for Display 
Name, Test, and Value. 

3. Select the Plain text filter 
checkbox at the bottom of the 
screen. This will change the screen 
into a large text area. 

4. Type your custom filter into the text 
area. 

5. Tap OK. 
6. The new filter will now appear in 

the filter grid. 
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Beginning a Session 
When you start the DataSplice Remote Client application, you will first be prompted to 
log in and begin your session.  DataSplice can function in two different modes – online 
and offline.  The process of beginning a session is slightly different, depending on which 
mode you are going to use. 

Logging In 
 
Logging In 

 

The first screen you will see when starting 
the DataSplice Remote Client is the login 
screen.  To log in, enter your user name 
and password in the corresponding fields.  
Select your correct domain from the 
Domain dropdown list.  If the domain you 
are looking for does not appear in the list, 
open the virtual keypad and enter it into 
the domain text field using the stylus.  
After your login information has been 
entered, tap the Connect button. 
 
Note: Please keep in mind that all user 
name, password, and domain information 
in DataSplice is case-sensitive. 

 
Once you have successfully logged in, you will be taken to the list of views.  If you are 
going to use DataSplice in online mode, you can continue on to using the views.  For an 
explanation of the views, please refer to the Views section later in this document.  If you 
are going to use DataSplice in offline mode, you will first need to obtain an offline 
session.  Please refer to the following Obtaining an Offline Session section for more 
information. 

Obtaining an Offline Session 
If you wish to use DataSplice in offline mode, you must first obtain an offline session 
after you have logged in.  This process caches the necessary offline data directly onto the 
handheld device.  This allows you to use the device in the same way that you would if 
you were in a normal online session.  The difference is that DataSplice will use and 
update the data that is actually stored on the handheld device, since an actual connection 
to the DataSplice Server is not possible without connectivity. 
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Getting Offline Data 

 

To get offline data, tap Session > Get Offline 
Data. 

This tells the DataSplice Server that you want to 
take your data from the Server and copy it to the 
handheld device so you can work offline.  

 

 
Selecting the Views to Download 

You will be shown a list of views.  Place a check 
mark beside each view for which you would like 
to download data to the handheld device.  By 
default, all of the views should be checked. 

Tap OK to continue.  
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Downloading Offline Data 

Based on your login name, the DataSplice Server 
will determine all of the necessary data to 
download to the handheld device. 

When the download is complete, the screen will 
display summary information about the data 
received.  To continue, tap OK.  

 
Disconnecting from the DataSplice Server 

Now that the necessary data has been cached on 
the handheld device, you can disconnect from the 
DataSplice Server and go offline. 

To disconnect from the DataSplice Server, tap 
File > Disconnect.  
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Disconnecting from the DataSplice Server (cont’d) 

 

You will see a checkbox to Release offline 
session and disconnect.  Leave this box 
unchecked and tap OK to continue. 

 
Successfully Obtained an Offline Session 

 

You have now successfully obtained an offline 
session and are working in offline mode. You can 
easily tell which mode you are in by referring to 
the far right section of the status bar. This should 
now say Offline. 

 
Once you have successfully obtained an offline session, the data is cached on the 
handheld device, allowing you to perform the desired tasks in offline mode.  Notice that 
the far right section of the status bar now says Offline.  This indicates that you are now in 
offline mode.  Another aspect to note is that offline data appears on the handheld with a 
green dot on the left of each record.  This signifies that the record data you are viewing is 
actually stored on the handheld. 
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Completing a Session 
After you have performed all of the desired tasks in the DataSplice Remote Client, you 
will want to end your session.  This process frees up the license you were using, and 
ensures that all of the changes you have made throughout your session have been 
successfully updated in the DataSplice Server.  The process of completing a session 
differs depending on whether you are working in an online or an offline session. 

Completing an Online Session 
To complete a session when you are working online, the process is very simple.  This is 
due to the fact that record modifications are synchronized with the DataSplice Server in 
real-time, since you are working online.  To complete an online session, simply tap File > 
Disconnect.  When you return to the login screen, your session and license have 
successfully been released. 

Completing an Offline Session 
The process of completing an offline session is slightly more involved.  It is important to 
remember that, during an offline session, all of the modifications you have made are 
stored on the handheld, not on the DataSplice Server.  To successfully complete the 
session, you need to reconnect and synchronize your modifications with the DataSplice 
Server. 
 
Connecting Back to the DataSplice Server 

When you are ready to connect back up with the 
DataSplice Server to synchronize your changes, 
tap the File menu and select the Connect menu 
option. 
 
Note: The handheld device must have a TCP/IP 
network connection to be able to communicate 
with the server, i.e. through the cradle using an 
Ethernet cable or ActiveSync (PC) connection, or 
a wireless network connection, etc. 
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Synchronizing Data and Continuing to Work Offline 

When you want to synchronize your record 
modifications and then continue to perform 
additional work offline, select the following 
options:  
 

1. Check Send changes to server 
2. Check Get updated data from server.  

The Release offline session and 
disconnect box will automatically be 
unchecked. 

3. Tap the OK button 
 
 
 

 
Synchronizing Data and Releasing Your Offline Session 

 

To synchronize your data when you are finished 
working: 
 

1. Check Send changes to server 
2. Check Release offline session and 

disconnect.  The Get updated data 
from server box will automatically be 
unchecked. 

3. Tap the OK button. 
 
 

 
 
 
 
 
 
 
 
 

  23



  
  
                                                                      DataSplice Mobile Computing – Inventory User Manual 
 
Uploading and Committing Changes 

 

After tapping the OK button from the previous 
screen, DataSplice begins the process of 
synchronizing your modifications on the 
handheld device with the DataSplice Server. If 
you selected Get updated data from server, 
then after the synchronization is complete, you 
will be returned to the view to continue working.  
If you selected Release offline session and 
disconnect, you will be taken to the login screen. 
 
Note: If there is a problem with one of the record 
changes you are trying to upload, you will 
receive an error: 

 

Tap OK to close the error dialog box. You will 
be taken directly to the record that caused the 
error, where you can fix the problem. Once you 
have corrected the problem, tap the Commit 

Changes button  and you will be taken back 
to the screen where your data is being uploaded 
to the server. 

 
Synchronization Finished 

If you selected Release offline session and 
disconnect, then after the synchronization is 
complete, the Remote Client will release its 
offline session and license, and return to the login 
screen. The handheld device is now ready to be 
used by a different user. 
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Views 
After you have successfully logged in and begun your session, you will be presented with 
the view list. 
 
View List 

 

The initial view list will only include a few 
views.  To access a particular view, tap on 
the view name with your stylus.  To return 
to the view list screen, tap the Show View 

List button . 
 
To perform some functions, you may need 
to change the view list to display all 
available views.  See the next table titled 
All Available Views for more information. 
 

 
All Available Views 

 

While this manual concentrates on only 
those views that are directly related to 
inventory, you may, at any time, see a list 
of all available views.  To do this, simply 
tap the Select drop-down list and select All 
Available Views from the list.  The 
DataSplice Remote Client will then show 
you a listing of all of the available views 
that you may choose from. 

For more information on the other 
available views not discussed in this 
manual, please refer to the other user 
manuals for those modules. 
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Inventory Transfer 
To get to the Inventory Transfer screen, you can tap its name from the main view list.  
You may also get to it by selecting the Transfer Selected Item link from the navigation 
menu at the bottom of the client window, and then tapping Go: 
 

 
 
Items can be transferred between locations by creating a transfer record.  The record 
contains an item number, quantity to be moved, original location, and final destination.  
This record is then automatically used by DataSplice to adjust the inventory balances at 
both locations. 
 
Inventory Transfer 

  

To transfer inventory items: 
 

1. In the filter field at the top, enter the 
Item Num to transfer. 

2. Tap the New Record button . 
3. Many of the fields will be 

automatically filled in with default 
values. Complete the remaining 
fields accordingly, such as the 
quantity to transfer in the Quantity 
field. 

4. When you have completed the 
fields, tap the Commit Changes 

button  to save the record and 
complete the transfer. 

Fields 
The Inventory Transfer view has multiple fields, as described below: 
 

Field Name Value
Item Num The identification number of the item being transferred 
Quantity The quantity of the chosen item to be transferred 

From Store The store ID that the transfer is coming from 
From Bin The bin ID that the transfer is coming from 
From Lot The lot ID that the transfer is coming from 
To Store The store ID that the transfer is going to 
To Bin The bin ID that the transfer is going to 
To Lot The lot ID that the transfer is going to 

Trans Date The date and time of the transfer 
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Issue of Material 
To get to the Issue of Material screen, you can tap its name from the main view list. You 
may also get to it by selecting the Issue the Selected Item link from the navigation menu 
at the bottom of the client window, and then tapping Go: 
 

 
 
The Issue of Material view is used to issue material to a work order, equipment number, 
general ledger account, or location. 
 
Issue of Material 

 

To issue material: 
 

1. In the filter field at the top, enter the 
Item Num you would like to issue. 

2. Tap the New Record button . 
Some of the fields will be 
automatically populated with 
default values. 

3. In the Quantity field, enter the 
quantity to issue. 

4. Complete the remaining fields as 
desired. 

5. When you have filled in the fields, 
tap the Commit Changes button 

 to complete the issue. 
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Fields 
The Issue of Material view has multiple fields. The following is a brief description of 
each: 
 

Field Name Value
Item Num The identification number of the item being issued 
Quantity The quantity of the chosen item to be issued 

Workorder The work order number 
Issue Unit The unit of measure of the item to be issued 
Issue To The person whom the item is issued to 

Equipment The equipment number to be issued 
Location The location of the material to be issued 

GL Debit Acct The general ledger debit account that will be affected by this transaction 
Trans Date The date of this transaction 
Description A description of the item 
Storeroom The store location of the item 

Bin The bin location of the item 
Lot The lot location of the item 
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Physical Count 
To get to the Physical Count screen, you can tap its name from the main view list.  This 
view allows you to take physical counts of items. 
 
Physical Count 

To take a physical count:  
 

1. In the filter fields at the top, enter criteria 
for the item you would like to count.  You 
can also use wildcards, such as %, to 
retrieve multiple records.  

2. Tap the Search button  to retrieve the 
records. 

3. In the Physical Count field, enter the 
count for the item. 

4. Tap the Commit Changes button  to 
save the record. 

Fields 
The Physical Count view has multiple fields.  Here is a brief description of each: 
 

Field Name Value
Item Num The identification number of the item being counted 

Bin The bin in which this item is located 
Current Balance The current balance of the item 
Physical Count The actual count of the item 

Desc A description of the item 
Issue Unit The unit of measure of the item 

Average Cost The average cost of the item 
Catalog Code The catalog code number of the item 
Manufacturer The manufacturer of the item 
Model Num The model number of the item 

Vendor Name The name of the item vendor 
Count Date The date and time that the count took place 
Storeroom The store location where the item resides 

Min The minimum acceptable value 
Max The maximum acceptable value 

SiteID The identifier for the site 
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Receive from PO 
To get to the Receive from PO view, you can tap its name from the main view list.  This 
view allows you to add items to inventory as they are received from a purchase order. 
 
Receive from PO 

 

To receive from a purchase order: 
 

1. Enter the purchase order number in the 
PO Num filter field.  

2. Tap the Search button .  The resulting 
records will show all of the remaining 
items that have yet to be received for that 
PO. 

3. In the corresponding fields, enter the 
quantity being received, the bin location 
(if not already set to the appropriate bin), 
and the other optional fields.  

4. When you have filled in the fields 
appropriately, tap the Commit Changes 

button  to finish the receipt. 
 
To reject items: 
 

1. Verify that the purchase order line has not 
been completed by examining the 
Complete field.  A completed line cannot 
reject items. 

2. In the Reject Qty field, enter the number 
of items rejected. 

3. In the Reject Code field, enter the code 
that corresponds to the reason for 
rejection. 

4. When you are done, tap the Commit 

Changes button . 
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Fields 
The Receive from PO view has multiple fields. The following is a brief description of 
each: 
 

Field Name Value
PO Num The purchase order identification number 

Line Num The line number of the purchase order 
Catalog Code The catalog code 

Item Num The identification number of the item 
New Qty The quantity acceptable in the delivery 
Remarks Any miscellaneous remarks 

Description A description of the item 
Order Qty The total quantity of the item ordered 
Order Unit The unit of measure of the item ordered 

Received Qty The quantity of the item actually received 
Pack Slip The pack slip 

Model Num The model number of the item 
Mfg The manufacturer of the item 

Complete This shows the status of the purchase order line (Y or N) 
Storeroom The storeroom that the item is being assigned to 

Bin The bin to which the item is assigned 
Lot The lot number of the item being received 

Workorder The number of the work order associated with the purchase order 
Location The location of the item being received 

Equipment The equipment number of the item 
SiteID The identifier for the site 

POLineID The ID for the purchase order line 
Reject Qty The quantity rejected in the delivery 

Reject Code The reason for the rejection of items 
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Return of Material 
To get to the Return of Material screen, you can tap its name from the main view list.  
You may also get to it by selecting the Return Item to Storeroom link from the 
navigation menu at the bottom of the client window, and then tapping Go: 
 

 
 
The Return of Material view is used to return issued items back into inventory. 
 
Return of Material 

 

To return issued material back into 
inventory: 
 

1. In the filter fields at the top, enter a 
Workorder of interest. 

2. Tap the Search button  to 
retrieve the records. 

3. To return an item from the existing 
list, edit the Qty Returning and 
Bin fields.  Then tap the Commit 

Changes button . 
4. To return an item that is not in the 

list, enter the item into the filter 
field, tap the New Record button 

 and enter the fields 
accordingly.  Then tap the Commit 

Changes button  to complete 
the return. 
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Fields 
The Return of Material view has multiple fields. The following is a brief description of 
each: 
 

Field Name Value
Item Num The identification number of the item being returned 
Quantity The quantity of the chosen item to be returned to inventory 

Workorder The work order number that the item being returned was originally issued to 
Issue Unit The unit of measure of the item to be returned 
Issue To The person whom the item is being returned to 

Equipment The equipment number to be returned 
Location The location of the material to be returned 

GL Credit Acct The general ledger debit account that will be credited by this item's return to inventory 
Trans Date The date of this transaction 
Description A description of the item being returned 
Storeroom The store location to return the item to 

Bin The bin location to return the item to 
Lot The lot location to return the item to 
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Search Inventory 
Search Inventory is a read-only view that allows you to find specific items in inventory.  
To get to the Search Inventory screen, you can tap its name from the main view list. 
 
Search Inventory 

To search the inventory: 
 

1. In the filter fields, enter the criteria you 
would like to search against. 

2. Tap the Search button  to display the 
results of the search. 

 
If you would like to issue an item once you have 
located it, you can do so by following the Issue 
the Selected Item navigation link.  For more 
information about issuing an item, please refer to 
the Issue of Material view. 
 

Fields 
The Search Inventory view has multiple fields. Here is a brief description of each: 
 

Field Name Value
Item Num The identification number of the item 

Description A description of the item 
Storeroom The storeroom or warehouse name 

Bin The bin number of the item 
Lot The lot number of the item 

Current Balance The current balance as reflected in bookkeeping 
Category The category of the item 

Min The minimum inventory level 
Max The maximum inventory level 

Issue Unit The unit of measure of the item 
Vendor The vendor of the item 

Catalog Code The vendor part number 
Model Num The manufacturer part number 

Mfg The manufacturer of the item 
SiteID The identifier for the site 
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Where Used 
Where Used is a read-only view that shows you where an item is being used.  To get to 
the Where Used screen, you can tap its name from the main view list.  You may also get 
to it from the Search Inventory view by selecting the Look-Up Where Used link from 
the navigation menu at the bottom of the client window, and tapping Go: 
 

 
 
This view shows you where the item is being used. 
 
Where Used 

To see where an item is being used: 
 

1. In the filter fields, enter the criteria you 
would like to search against.  If you 
arrived at this view by using the 
navigation link from another view, the 
filter field will already be filled in. 

2. Tap the Search button  to display the 
results of the search. 

 
 

Fields 
The Where Used view has multiple fields. The following is a brief description of each: 
 

Field Name Value
Equipment The equipment number 
Item Num The identification number of the item 
Item Desc A description of the item 
Quantity The quantity of the item 

Spare Desc Another description of the item 
SiteID The identifier for the site 
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